Using a Geometry Drawing Utility

Introduction

In the time of Plato, a compass and straightedge were the norm for constructions. Today, many other tools are available, including technology. The Principles and Standards for School Mathematics (NCTM 2000) asserts that technology is essential in teaching and learning mathematics; it influences the mathematics that is taught and enhances students’ learning. (p. 24).

In this appendix, we present a series of labs appropriate for a computer geometry utility. Most geometry utilities allow both drawing and construction. In a drawing, an “eyeballing” approach is used to draw a figure to look as it should, but the figure may not be constrained by elements of its geometric properties. For example, a segment may be drawn in a circle to look like a diameter, as in Figure AIII-1(a). However, if it is not constructed to pass through the center of the circle and one moves the circle as in Figure AIII-1(b), the segment may no longer move with the circle and may not appear to be a diameter.

![Figure AIII-1](image)

In Figure AIII-1(b) the constraint of having the diameter pass through the center was not used. If the segment is constructed as a chord to contain the center as a part of the...
construction, then when the circle is moved, the segment moves accordingly (as a diameter should). For most purposes in this appendix, we are using constructions with all the geometric constraints applied.

The Lab Activities in this appendix are arranged in the order they might be used with the geometry chapters of the book. The activities may be used independently if the teacher provides the language and definitions as needed. Some of the materials in this appendix are based on the work of Jim Williamson and Terry Souhrada at the University of Montana.

**About a Geometry Utility**

Figure AIII-2 is an example of a drawing window with the Toolbox and Menu bar shown from *The Geometer's Sketchpad (GSP)*. Other utilities have different windows, but we use GSP for illustrations in this appendix.

The Menu bar of Figure AIII-2 shows the following menu options:

- **File**, for opening, closing, saving, and printing documents.
- **Edit**, for selecting objects, editing object properties, and setting preferences.
- **Display**, for changing the appearance of drawings.
- **Construct**, for constructing figures.
- **Transform**, for translating, rotating, dilating, reflecting, and iterating figures.
- **Measure**, for displaying measurements and making calculations.
- **Graph**, for options with coordinate axes and function plots.
- **Window**, for minimizing, zooming, or bringing all to front.
- **Help**, for accessing Sketchpad’s help system.
The Laboratory Activities that follow contain a reference to a section in the book where they are appropriate to use. In many cases, the mathematical content of a section can be explored by working through the appropriate activity. GSP Lab 1 provides an introduction to GSP and can be used to acquaint users with the main features of the program. Additional features will be introduced as needed. More activities and problems are given in Assessment A-III. Many of the Technology Corners in Chapters 11–14 also contain GSP activities or problems.

The Geometer’s Sketchpad

GSP Lab 1 (Section 11-1)

What Is GSP?
The Geometer’s Sketchpad (GSP) is a graphics program that allows us to

• Simulate straightedge and compass constructions.
• Save the steps in a construction so that we can do them over and over again.
• Explore and discover mathematical, especially geometric, properties.

Accessing GSP
Double-click on the GSP icon. In a second, the GSP title box appears on the screen. Then the GSP window appears in the background. Click anywhere inside the title box to activate the GSP window. (See Figure AIII-3.)
Think of the window as a “blank sheet of paper” on which we can draw a sketch. On the left side of the window is the Toolbox. Each icon stands for a different tool. In this lab, we experiment with some of these tools to learn how GSP operates.

**Working with GSP**

As we work through the exercises, keep an eye on the Status Line in the lower left (Windows) or lower right (Mac) corner of the sketch. This box explains exactly what GSP is doing. It can be a real help if you are unsure about what is going on!

1. a. Click on the POINT tool. How does GSP indicate that the POINT tool is active?  
   b. Notice how the cursor changes when you move it onto the sketch. Click to create several points.  
   c. Choose the TEXT tool. How does the cursor change?  
   d. Click on each point created. What happens?

GSP automatically labels points with capital letters, starting with A, then B, and so on. You can change a label using the TEXT tool; just double-click on the label. A box will appear that allows you to type any label wanted. Try it!

2. With the TEXT tool active, double-click in an empty part of the sketch. A text box is created that can be used to type captions in the sketch. After typing a caption, use the ARROW tool to “grab” the caption (point with the mouse and hold the button down) and move it around the sketch (“drop” it by releasing the mouse button). Go back to the TEXT tool to edit the caption.

3. Place several points in the sketch. Then choose the ARROW tool. Notice the cursor is now an arrow. Click on a point. How does GSP tell that the point has been selected? Click anywhere else in the sketch to deselect it.

With the ARROW tool active, you can select several points at once by dragging a selection rectangle around them. Start in one corner and hold the button on the mouse down while the cursor is dragged down and over. A dashed box is drawn. When the button is released, everything inside the box is selected. Notice that if you click the mouse button in blank space, everything gets deselected.

Another way to select several objects at the same time is simply by selecting them with the ARROW tool one by one. Click on an unselected object to select it, click on a selected object to deselect it, click in blank space to deselect all objects. Experiment with it.

If the “drag” method is used to select multiple objects but a few more are wanted, you can drag over a number of objects, then press and hold the SHIFT key to drag over more objects, perhaps into a different location on the screen.

You can get rid of created objects by selecting them and pressing the DELETE or BACKSPACE key. Experiment with those keys.

Finally, all the objects on the screen can be selected by using the Select All command found in the Edit menu at the top of the screen while the ARROW tool is active. Select the remaining points and delete them. Note: If the POINT is active, only points will be selected using this method. Likewise, if the COMPASS tool, one of the STRAIGHTEDGE tools, or the TEXT tool is active, only objects of that type will be selected.

4. Choose the COMPASS tool.

   a. To create circles in a sketch, click the mouse button once to create the center point, then click elsewhere to create the radius point (or click, drag, and release).
b. Use the TEXT tool to label the two points.
c. Choose the ARROW tool. Drag either of the points. What happens?
d. Point at the circle and select it. How does GSP indicate that the circle has been selected?

5. Clear any objects from the sketch.
a. Choose the SEGMENT tool. (If the SEGMENT tool isn’t showing, press and hold down the button on the current STRAIGHTEDGE tool to see the three available options: SEGMENT, RAY, and LINE.)
b. To create a segment in the sketch, click at two locations where you’d like the two endpoints to be. The segment is selected. Use the TEXT tool to see what kinds of labels are assigned to segments.
c. Go back to the Toolbox and choose the LINE option of the STRAIGHTEDGE tool. Return to the sketch and see how lines are drawn and labeled. Do the same with the RAY option.

The Construct Menu

The Construct menu on the Menu bar across the top of the sketch contains some very powerful tools. A key idea for GSP success is:

Whenever possible, use a command from the Construct menu to define objects.

6. Here is an example of how to use the Construct menu.
a. Use the POINT tool to create two points. Use the SELECT ARROW tool to select both points. (If you hold down the SHIFT key while creating the points, they remain selected.)
b. Choose Segment from the Construct menu.

7. a. Clear the objects and then use the POINT tool to create three points. Select the three points, then use the segment construction. What happens?
b. Can we move the points around after the construction?
c. Can we move the segments around?

8. a. What happens when you use the segment construction with four points?
b. Does the order in which you select the four points matter?

9. There are two ways to find the point(s) where two objects intersect.
a. Clear any objects from the screen. Draw two circles that intersect. Then draw a ray and a segment that intersect.
b. Method 1: Select the two circles, then choose Intersections from the Construct menu. What happens?
c. Method 2: Choose the ARROW or POINT tool from the Toolbox. Move the cursor so that it points at the intersection of the segment and the ray. Be careful—look at the status line to be sure that GSP recognizes that the intersection point is desired. Then click the mouse button once.

If you want a new window, choose New Sketch from the File menu. You can have several sketches available at one time. Note: There is a Window menu in Windows GSP but not in all versions of Mac GSP.
The Measure Menu

10. **a.** In a new sketch, draw a segment and select it. Choose **Point On Segment** from the **Construct** menu. What happens? Go back to the **SELECTION ARROW** tool and deselect the point by clicking on an empty space of the sketch.

   **b.** Select the segment. Pull down the **Measure** menu and choose **Length**. What happens? *(Note: You can select the unit of measurement, inches, centimeters, or pixels, by going to **Preferences** in the **Edit** menu.)*

   **c.** Select an endpoint of the segment and the point on the segment. Choose **Distance** from the **Measure** menu. What happens?

11. You can use **Calculate** in the **Measure** menu to do calculations with numbers, measurements, and functions.

   **a.** Choose **Calculate** from the **Measure** menu. A calculator should appear. Click on one of the measurements on the screen. Next, click on the minus sign (−) on the key pad. Finally, click on the second measurement. Click on **OK** and the difference of the measurements should appear on the screen.

   **b.** Select the point on the segment and move it back and forth. What happens to the measurements and the difference?

   **c.** Change the length and position of the segment by dragging one of the endpoints. What happens to the measurements and the difference?

GSP Lab 2: Measuring Angles of Polygons
(Sections 11-2 and 11-3)

1. **a.** Open a new sketch.

   **b.** Construct a triangle using three points from the **POINT** tool (keep the **SHIFT** key pressed) and **Segment** from the **Construct** menu and label its vertices.

   **c.** Measure each interior angle of the triangle.

**Measuring an Angle**

To measure an angle:

- Select three points that determine the angle. Be sure the vertex is the second point selected.
- From the **Measure** menu, choose **Angle**. The measure of the angle will appear on the sketch.

**Calculating a Sum**

**d.** Calculate the sum of the interior angles of the triangle.

To calculate a sum:

- Open the Calculator by choosing **Calculate** from the **Measure** menu.
- Enter a measurement to be added by clicking on the desired measurement. *(Note: It is possible to enter numbers on the calculator keypad as well, but these numbers will not be updated when the sketch is changed.)*
- Click on the desired operation on the calculator keypad.
• Continue to alternate between selecting measurements from the sketch and operations on the calculator until all measurements and operations needed are entered. When you are done, click on **OK**. The operation and result appear on the sketch.
e. Move the vertices of the triangle to change its size and shape. What happens to the sum of the measures of the interior angles?

**Making a Conjecture**

f. Repeat part (e) several times, then make a *conjecture* (that is, an educated guess based on your observations) about the sum of the measures of the interior angles of a triangle.

2. a. Repeat exercise 1(b–f) for the following convex polygons: a quadrilateral, a pentagon, and a hexagon. Use the results to make a conjecture about the sum of the interior angles of a convex *n*-gon (a polygon with *n* sides).

**Testing Your Conjecture**

b. Test the conjecture by repeating exercise 1(b–f) for a convex octagon.
3. a. Open a new sketch.
b. Construct a triangle. Moving clockwise, label the vertices *A*, *B*, and *C*. Form the exterior angles of the triangle by selecting two points and then choosing **Ray** from the **Construct** menu. Construct rays \(AB\), \(BC\), and \(CA\). Place a point on each ray so that you can measure each angle. Calculate the sum of the measures of the exterior angles.
c. Change the size and shape of the triangle several times. What happens to the sum of the measures of the exterior angles?
d. What seems to be true about the sum of the measures of the exterior angles of a triangle? Record your conjecture in a caption in the sketch.
e. Repeat parts (b–d) for the following convex polygons: a quadrilateral, a pentagon, and a hexagon. Use the results to make a conjecture about the sum of the measures of the exterior angles of a convex *n*-gon.
f. Test the conjecture in part (e) by repeating parts (b–d) for a convex octagon.

**GSP Lab 3: Regular Polygons (Section 11-2)**

The 4.07 and later versions of **GSP** contain the **Polygons Custom Tool** from **Custom Tools** on the **Tool Box**. The **Polygons** tool enables the user to automatically draw squares, regular triangles, pentagons, hexagons, octagons, and 17-gons. For details on creating custom tools, see **GSP Lab 10** and for selecting **Polygons** and other sample tools, see your **GSP** manual or the **Help** menu.

In this section, we construct regular polygons by using the **Rotate** command from the **Transform** menu. Transformations and rotations in particular can be easily understood and practiced using **GSP**; they are discussed in detail in Chapter 12.

**The Transform Menu**

1. a. In a new sketch, draw a segment \(\overline{AB}\) and select point *A*.
b. Go to the **Transform** menu and choose **Mark Center**.
Using a Geometry Drawing Utility

c. Select segment $\overline{AB}$ and point $B$. Go back to the Transform menu and choose Rotate . . . A dialog box allows you to tell GSP how many degrees to rotate the selected objects. The central angle of a regular pentagon is $72^\circ$; put that number in the box and click on OK. What happens?

d. Continue to rotate the segment and point around point $A$ until there are five segments, each making a $72^\circ$ angle with the next one at the center $A$. What are the labels on the points? (Depending on the Preferences setting, labels may not be showing.)

e. Now connect the vertices to make a regular pentagon, as in Figure AIII-4(a). Why does a rotation of $72^\circ$ result in the vertices of a pentagon?

2. a. In a new sketch, create a regular hexagon, as in Figure AIII-4(b), using the method in exercise 1 but adjusting the angle measure.

b. By how many degrees did you rotate the segment around the center each time to create a regular hexagon?

c. By how many degrees would you rotate the segment each time to create a regular $n$-gon?

There are two ways to create a circle using the Construct menu.

3. The first way is to use a center point and a radius.

a. Create a segment and a point not on the segment. Select them both.

b. From the Construct menu, choose Circle By Center + Radius. Notice that the segment (the radius) does not have to have the center of the circle as one of its endpoints.

c. What happens to the circle if the center is moved?

d. What happens if the length controlling the radius is changed?

4. The second way is to use two points.

a. In a new sketch, create and select two points.

b. From the Construct menu, choose Circle By Center + Point. Select the points in the opposite order. Does the order of selecting points matter?

5. a. In a new sketch, draw a segment.

b. Use two circles to create an equilateral triangle that has the segment in part (a) as one of its sides. The size and position of the triangle can be changed by dragging a vertex, but it should always remain an equilateral triangle.

To hide objects:

- Select all the objects to be hidden.
- From the Display menu, select Hide Objects (or Points, Lines, etc.).

c. Hide everything except the triangle and its vertices.

GSP Lab 4: Congruent or Not Congruent? (Section 12-1)

Side-Side-Side

1. In a new sketch, draw $\triangle ABC$. Measure its sides and angles.

In part 2 below, we construct a triangle, $\triangle XYZ$, whose sides are congruent to the sides of $\triangle ABC$. 
2. a. Create a point \( X \). Next, construct \( XY \), a copy of \( AB \). Select \( X \) and \( AB \). Use the \textbf{Circle By Center + Radius} command from the \textbf{Construct} menu to construct a circle. What is the center of the circle? What is the radius of the circle? What does the circle represent?
b. Select the circle and use \textbf{Point On Circle} to construct a point on the circle; label it \( Y \). Construct \( XY \). What is true about the measures of segments \( XY \) and \( AB \)? Hide the circle.
c. Side \( XZ \) in \( \triangle XYZ \) will be congruent to side \( AC \) in \( \triangle ABC \). To create \( XZ \), first find the possible locations of point \( Z \) from \( X \). Use the \textbf{Circle By Center + Radius} command to construct a circle with radius \( AC \) and center \( X \). What does this circle represent?
d. Side \( YZ \) in \( \triangle XYZ \) will be congruent to \( BC \). To create \( YZ \), find the possible locations of point \( Z \) from \( Y \). Use the \textbf{Circle By Center + Radius} command to construct a circle with radius \( BC \) and center \( Y \).
e. There are two possible locations for point \( Z \). Construct one of the points and label it \( Z \). Construct \( XZ \) and \( YZ \) to complete \( \triangle XYZ \). Then hide the two circles.

3. a. Measure the sides and angles of \( \triangle XYZ \). How are \( \triangle ABC \) and \( \triangle XYZ \) related? Support your answer.
b. Change the shape and size of \( \triangle ABC \). Does the relationship between the triangles change?
c. When the sides of one triangle are respectively congruent to the sides of another triangle (SSS), what appears to be true about the triangles?

\textbf{Side-Angle-Side}

4. Draw a new triangle, \( \triangle PQR \). Measure its sides and angles.

In exercise 5, we construct a triangle, \( \triangle LMN \), that has two sides and the angle between them congruent, respectively, to two sides and the included angle in \( \triangle PQR \).

5. a. Use the method from exercises 2(a) and 2(b) to construct \( LM \) with the same measure as \( PQ \). Use the \textbf{Line} command from the \textbf{Construct} menu to construct ray \( LM \) as well. Hide the circle.
b. Next construct a copy of \( \angle QPR \) with its vertex at \( L \). To do this, first select \( \angle QPR \) by selecting points \( Q, P \), and \( R \) in that order. Then, choose \textbf{Mark Angle} under the \textbf{Transform} menu. What happens?
   Select point \( L \). Choose \textbf{Mark Center} from the \textbf{Transform} menu. Create a copy of \( \angle QPR \) by selecting \( LM \) and rotating it using the \textbf{Rotate} command from the \textbf{Transform} menu. When the dialog box appears, choose \textbf{By Marked Angle}. What happens?
c. Construct \( LN \) congruent to side \( PR \) in \( \triangle PQR \) by constructing a circle with center \( L \) and side \( PR \) as a radius. Construct point \( N \) at the intersection of the circle and the rotated ray.
d. Complete the triangle by constructing \( MN \). Hide the two rays and the circle and connect the points \( M, L, \) and \( N \).

6. a. How are \( \triangle LMN \) and \( \triangle PQR \) related?
b. Change the shape and size of \( \triangle PQR \). Does the relationship between the triangles change? Measure the sides and the angles of \( \triangle LMN \). How do these measures compare to the measures of \( \triangle PQR \)?
c. When two sides and the included angle in one triangle are congruent to two sides and the included angle in another triangle (SAS), what appears to be true about the triangles?

**Side-Side-Angle**

7. a. In a new window, draw a new scalene triangle, \( \triangle TUV \). Measure its sides and angles. We will attempt to construct a triangle \( \triangle DEF \) that is congruent to \( \triangle TUV \) using two sides and a nonincluded angle. Adjust the triangle so that \( TU > UV \).

b. Construct \( DE \) with the same length as side \( TU \). Use points \( D \) and \( E \) to construct ray \( DE \).

c. Construct the set of possible locations for \( F \) so that \( EF \) will have the same length as side \( UV \). (Construct the circle with center \( E \) and radius \( UV \).)

d. Construct a copy of \( \angle UTV \) with its vertex at \( D \). Remember to first select \( \angle UTV \). Then, under the **Transform** menu, choose **Mark Angle**. Select point \( D \). Under the **Transform** menu, choose **Mark Center**. Finally, create the copy of \( \angle UTV \) by selecting \( DE \) and rotating it using the **Rotate** command.

e. There should be two possible places where \( F \) could be located. Label one of them \( F \) and the other one \( G \). Draw \( EF \) and \( EG \). Hide any remaining circles.

Are \( \triangle DEF \) and \( \triangle TUV \) congruent? Explain.
Are \( \triangle DEG \) and \( \triangle TUV \) congruent? Explain
Are \( \triangle DEF \) and \( \triangle DEG \) congruent? Explain.

f. If we know that two sides and a nonincluded angle in one triangle are congruent to two sides and a nonincluded angle in another triangle (SSA), is that enough information to determine that the triangles are congruent? Explain.

**GSP Lab 5: Circles and Chords (Section 12-1)**

**Drawing and Bisecting Chords**

In this lab we explore some relationships among circles, radii, and chords.

1. a. Construct a large circle by drawing a segment and a point, using the **Circle By Center + Radius** command. Then place two points on the circle by selecting the circle and using **Point On Circle** from the **Construct** menu.

b. Construct the segment joining the two points. A segment joining two points on a circle is a **chord** of the circle. Move one end of the chord so that the chord is clearly visible.

c. Construct a **perpendicular bisector** of the chord; that is, a line that bisects the chord and is perpendicular to it, by performing the following steps:
   - Select the segment. Choose **Midpoint** from the **Construct** menu.
   - Select the segment and the midpoint. Choose **Perpendicular Line** from the **Construct** menu. What happens?

d. What happens if you move one of the points on the circle? What happens if you change the radius of the circle?

e. Create another chord on the circle and construct its perpendicular bisector. What do you notice about the intersection of the two perpendicular bisectors?

f. Change the location of the chords and the size of the circle. How does this affect the intersection of the two perpendicular bisectors?
Constructing a Circle Circumscribed about a Triangle

2. a. Draw a triangle \( ABC \) as in Figure AIII-5. Construct the perpendicular bisectors of two sides of the triangle as shown.
   b. Construct point \( D \) at the intersection of the two perpendicular bisectors.
   c. Draw segment \( BD \).
   d. Construct the circle \( D \) as its center and \( BD \) as a radius, as shown in Figure AIII-5.
   e. Describe the relationship between the triangle and the circle.
   f. Move the vertices of the triangle to change its shape and size. How does this affect the relationship between the circle and the triangle?
   g. If you were to construct the perpendicular bisector of the third side of the triangle, would it intersect the other two? If so, where?

3. a. Create three noncollinear points and construct a single circle that contains them using the approach in exercise 2.
   b. Describe how the circle was found and how this relates to exercise 2.

4. Following is a semiautomatic way to construct a circle circumscribed about a given triangle.
   a. Construct any triangle and label its vertices as \( A \), \( B \), and \( C \). Then select points \( A \), \( B \), and \( C \) in that order and select the command Arc Through 3 Points from the Construct menu.
   b. Deselect the arc (by clicking on any empty space on the screen).
   c. Select the points \( B \), \( C \), \( A \) in that order.
   d. Select, as in part (a), the command Arc Through 3 Points to obtain another arc, which together with the arc in part (a) makes the required circle.

REMARK Sample Tools contains the custom tool circumcircle among other tools. This custom tool constructs a triangle and its circumcircle given three points.

GSP Lab 6: Circles Circumscribing Rectangles (Section 12-2)

1. a. Construct two congruent segments \( AB \) and \( CD \) that bisect each other at \( O \), as in Figure AIII-6. (This can be accomplished by constructing two nonparallel congruent segments and their midpoints and then translating one segment by a translation that takes its midpoint to the other midpoint.) Construct the quadrilateral \( ACBD \). Drag one of the vertices to different locations. What kind of quadrilateral is \( ACBD \)? Why?
   b. Use the construction in part (a) and construct a circle with center \( O \) and radius \( OD \). Why are the vertices of the quadrilateral on the circle?

2. a. Draw a circle and any diameter \( AB \) of the circle, as in Figure AIII-7. Choose any point \( C \) on the circle. Measure \( \angle ACB \). Drag point \( C \) to different locations on the circle. What happens to \( m(\angle ACB) \)?
   b. Use parts (a) or (b) of exercise 1 to explain what you observed about \( m(\angle ACB) \).
3. a. Draw any quadrilateral. How would you check if a circle that circumscribes it exists?
   b. Draw a circle and choose four points $A$, $B$, $C$, $D$ on the circle, as shown in Figure AIII-8. Connect the points to construct the quadrilateral $ABCD$. Choose a point $E$ on $AD$ that is outside the circle.
   c. Measure $\angle ABC$, $\angle ADC$, and $\angle EDC$. Now drag vertex $C$ and observe the measurements of the three angles. What do you notice?
   d. Make a conjecture stating which quadrilaterals are cyclic (can be inscribed in a circle).

![Figure AIII-8](image)

**GSP Lab 7: Split the Sides (Section 12-4)**

1. a. Start with a new sketch. Draw $\triangle ABC$. Construct a point $M$ on $\overline{AB}$.
   b. Construct a segment $MN$ such that $MN$ is parallel to $\overline{AC}$ and $N$ is on $\overline{BC}$, as in Figure AIII-9.

![Figure AIII-9](image)

c. Measure $BM$, $BN$, $BA$, and $BC$. What is true about the ratios $\frac{BM}{BA}$ and $\frac{BN}{BC}$?

d. Drag point $M$ to a new position. What is true about the ratios $\frac{BM}{BA}$ and $\frac{BN}{BC}$?

2. What are the ratios $\frac{BM}{BA}$ and $\frac{BN}{BC}$ when $M$ is the midpoint of $\overline{AB}$?

3. a. Drag $B$ to form a new triangle. What is true about the ratios $\frac{BM}{BA}$ and $\frac{BN}{BC}$?
   b. Drag point $M$ to a new position. What is true about the ratios?
4. a. Measure $MN$ and $AC$. How does the ratio $\frac{MN}{AC}$ compare to the ratios $\frac{BM}{BA}$ and $\frac{BN}{BC}$?

b. Drag $B$ to form a new triangle. Now how do the ratios in part (a) compare?

5. What seems to be true when a segment intersects two sides of a triangle and is parallel to the third side?

6. What can you conclude about $\triangle ABC$ and $\triangle MBN$? Justify your answer.

GSP Lab 8: Mysterious Midpoints (Section 12-9)

1. a. Start with four points that will form the vertices of a convex quadrilateral. Draw the quadrilateral.

b. Construct the midpoints of the sides of the quadrilateral and connect the midpoints to form a new polygon, as shown in Figure AIII-10.

c. What kind of quadrilateral is the new polygon? Why?

d. What happens when you change the shape of the original quadrilateral?

Repeat exercise 1 starting with four points that are the vertices of

2. A rectangle.

3. A square.

4. A rhombus.

5. A kite.

6. Label the midpoints of the sides of the original quadrilateral $ABCD$ by $M, N, P, Q$, as shown in Figure AIII-10. Construct the diagonals $AC$ and $BD$ and label some of the points of intersection of the various segments as shown. Conjecture what kind of quadrilateral $EMFO$ is.

7. a. Follow the steps below:

i. Construct two congruent intersecting segments that are neither perpendicular to nor bisect each other.

ii. Construct the quadrilateral whose diagonals are the constructed segments in part (i).

iii. Construct the midpoint-quadrilateral of the quadrilateral in part (ii).

b. Conjecture what kind of quadrilateral the midpoint quadrilateral in part (iii) is.

c. Complete the following statement and justify it. The midpoint quadrilateral is _____ if, and only if, the diagonals of the original quadrilateral are congruent.

8. a. Construct two segments that are perpendicular to each other but not congruent. Make these segments the diagonals of quadrilateral $ABCD$. (You may choose any segment and rotate it by an appropriate angle about a point not on the segment.) Next construct the midpoint quadrilateral. Check, by dragging, what kind of quadrilateral it always is.

b. Complete the following statement and justify it: The midpoint quadrilateral is a rectangle if, and only if, the diagonals of the original quadrilateral are _____.

c. Drag one of the vertices of the quadrilateral $ABCD$ in part (a) so that the midpoint quadrilateral becomes a square. Complete the following: The midpoint quadrilateral is a square if, and only if, the diagonals of the original quadrilateral are _____.

d. Based on your answer to part (c), construct two segments to serve as diagonals of the original quadrilateral for which the midpoint quadrilateral is a square. Check, by dragging, that it always is a square.
9. Which of the following statements are true? Explain why. If a statement is false, change part of the “if, and only if,” phrase to make the statement true.
   a. The midpoint quadrilateral is a rectangle if, and only if, the original quadrilateral is a rhombus or a kite.
   b. The midpoint quadrilateral is a square if, and only if, the original quadrilateral is a square.

**GSP Lab 9: Areas of Polygons (Section 13-2)**

**REMEMBER** Whenever possible, use a command from the **Construct** menu to define objects.

1. Start with a new sketch. Choose **Preferences** from the **Edit** menu and make sure that the **Distance Unit** is cm and the **Precision** is set to hundredths for both distance and scalars.
2. Complete the following steps to construct the rectangle with a line containing one side shown in Figure AIII-11.

   ![Figure AIII-11](image)

   a. Draw a horizontal segment \( \overline{AB} \).
   b. Construct lines through \( A \) and \( B \) perpendicular to \( \overline{AB} \).
   c. Construct a point \( C \) on the line through \( A \) and construct a line through \( C \) parallel to \( \overline{AB} \). Construct the point of intersection of this line and the vertical line through \( B \). Label the point \( D \).
   d. Hide the two vertical lines and complete the rectangle by constructing segments \( \overline{AC} \), \( \overline{BD} \), and \( \overline{CD} \).
   e. Show the label for \( \overline{AB} \) and change it to \( b \) for base. Show the label for \( \overline{AC} \) and change it to \( b \) for height. Measure the lengths of \( b \) and \( h \).
3. In this exercise, we review how to find the area of a rectangle.
   a. Choose **Show Grid** from the **Graph** menu. Hide the two axes and two new points.
   Choose **Snap Points** from the **Graph** menu. Drag \( A \) and \( B \) so that they snap to points on the grid, making \( \overline{AB} \) horizontal. The length \( b \) should be a whole number.
   b. Drag \( C \) so that \( \overline{CD} \) passes through grid points. \( C \) won’t snap to the grid, but drag \( C \) so that \( b \) is very close to a whole number.
   c. Count the number of squares in the rectangle. How does the number of squares appear to be related to \( b \) and \( h \)?
   d. Use **Calculate** from the **Measure** menu to create an algebraic expression in terms of \( b \) and \( h \) that gives the area of the rectangle. Check that the expression works by dragging \( A \), \( B \), and \( C \) to form a rectangle with a different height and base and counting the number of square units as in part (c).
4. Now we investigate the area of a parallelogram using the sketch from exercise (3).
   a. Use Point On Parallel Line from the Construct menu to place a point $G$ on $CD$. Then construct $AG$.
   b. Construct a line through $B$ parallel to $AG$. Construct the point where this line intersects $CD$ and label it $H$. Hide $BH$ and construct $BH$. Measure $AG$ and $BH$.
   c. Construct the polygon interior $AGHB$ by selecting the vertices of the parallelogram in order and then choosing Quadrilateral Interior from the Construct menu.
   d. As you move point $G$, what measures in the sketch change? What measures stay the same?
   e. How are the heights of the parallelogram and the rectangle related? How are the lengths of their bases related?
   f. Measure the area of the parallelogram by selecting its interior and then choosing Area from the Measure menu.
   g. How does the area of the parallelogram change as we drag $G$? How does the area of the parallelogram compare to the area of the rectangle?
   h. Write a rule for finding the area of a parallelogram. Move points $A$ and $C$ to check that the rule works for parallelograms with different heights and bases.

5. Now we investigate the area of a triangle.
   a. In a new sketch, draw two segments $IJ$ and $IK$. Construct a line through points $I$ and $K$. Construct the altitude $IL$ from $I$ to $IK$, as shown in Figure AIII-12(a).
   b. Construct $IK$. Show the label for $IK$ and change it to base. Show the label for $IL$ and change it to height. Measure the height and base of $\triangle IJK$.
   c. Construct the midpoint $M$ of $IK$. Select $M$ and choose Mark Center from the Transform menu.
   d. Select $I$, $IJ$, and $IK$. Then choose Rotate from the Transform menu and rotate the selected objects by a fixed angle of $180^\circ$ to obtain a figure as in Figure AIII-12(b).
   e. What kind of quadrilateral is $IJK'$? Does the shape change when you drag the vertices of $\triangle IJK'$?

Figure AIII-12
Using a Geometry Drawing Utility

f. How are the heights of $\triangle IJK$ and quadrilateral $IJI'K$ related? How are the lengths of their bases related?

g. What is the formula for the area of quadrilateral $IJI'K$?

h. How does the area of $\triangle IJK$ compare to the area of quadrilateral $IJI'K$ as shown in Figure AIII-12(c)? Check the answer by constructing their interiors and measuring their areas.

i. Use the results from parts (f–h) to write a rule for finding the area of a triangle. Record the rule in a caption.

6. Next, we investigate the area of a trapezoid.
a. In a new sketch, construct a trapezoid with exactly one pair of parallel sides. Label the parallel sides $b_1$ and $b_2$ by typing $b[1]$ and $b[2]$ for the labels.
b. Construct a segment that is perpendicular to the parallel sides and has its endpoints on them. This is an altitude of the trapezoid. Label it $a$ for altitude.
c. Construct the midpoint of one of the nonparallel sides and rotate the trapezoid $180^\circ$ about this point. What kind of shape is formed?
d. What is the length of a base of this “doubled” trapezoid?
e. Based on the observations, write a formula for the area $A$ of a trapezoid using $b_1$ for the length of one base, $b_2$ for the length of the other base, and $a$ for the height (the length of the altitude).

GSP Lab 10: Right on Pythagoras (Section 13-3)

In this lab, we explore the relationships among the sides and angles in a triangle. To make your work easier, we create a custom tool.

1. When we plan to repeat a complex procedure several times, GSP allows us to record steps in a custom tool. Once the tool has been recorded, we can use it to repeat the procedure when we need it. In this exercise, we create a custom tool for constructing a square with a given side.

a. Draw a segment $\overline{AB}$.
b. Select one endpoint of $\overline{AB}$. Then choose Mark Center from the Transform menu.
c. Select $\overline{AB}$ and the other endpoint of the segment. From the Transform menu, choose Rotate . . . . Enter 90 in the dialog box.

d. Mark the new endpoint of the new segment as the center.
e. Select the newest segment and its other endpoint. Rotate them 90 degrees about the center in part (d).
f. Construct the remaining side of the square.
g. Select the entire figure (four segments and four points). Press and hold the Custom Tools tool (the bottom tool in the Toolbox) and choose Create New Tool from the menu that appears. Name the tool “Square” and press the OK button.
h. Press and hold the Custom Tools tool. You should see the new tool, Square, listed in the menu that appears. We’ll use the tool later in the activity.

2. Construct a right triangle, $\triangle CDE$, with the right angle at $D$ as shown in Figure AIII-13. (Note: We should be able to change the size and shape of $\triangle CDE$ by dragging its vertices, but $\angle D$ should always be a right angle.)
a. The longest side of a right triangle is the **hypotenuse**. Which side of $\triangle CDE$ is the hypotenuse?

b. The other two sides are the **legs** of the right triangle. Name the legs of $\triangle CDE$.

In the next exercise, we use the tool you created in exercise 1 to construct a square on each side of $\triangle CDE$, as shown in Figure AIII-13. The sides of each square should be congruent to the side of the triangle on which it is constructed.

3. a. Choose the **Custom Tools** tool by clicking its icon in the Toolbox. This activates the most recently created or used tool—in this case, **Square**.

b. Click on points $C$ and $E$ in the sketch. A square is constructed on $CE$. (If the square is constructed toward the inside of $\triangle CDE$, rather than outside, choose **Undo Square** from the **Edit** menu, then redo this step, clicking on $C$ and $E$ in the reverse order as before.)

c. To see what's going on under the hood, choose **Show Script View** from the **Custom Tools** menu. Notice that two points are listed as **Givens**, meaning that the entire construction is derived from two initial points. With the Script View still open, deselect everything in the sketch, then select points $E$ and $D$. Two buttons appear at the bottom of the script: **Next Step** and **All Steps**. Click **Next Step** repeatedly to see the construction played out step-by-step.

d. Use the **Square** tool to construct a square on the remaining side of $\triangle CDE$.

e. Move the vertices of the triangle. What happens to the constructed squares?

4. a. Create the interior of each square and measure its area. How is the area of each square related to the length of the side of the triangle on which it is constructed?

b. Drag the vertices of $\triangle CDE$ and look for a relationship among the areas of the three squares. Use a calculator to confirm your conjecture.

c. Complete the following statement: In a right triangle, if $a$ and $b$ are the lengths of the legs and $c$ is the length of the hypotenuse, then _____. This is the **Pythagorean Theorem**.

5. a. Next we explore how the angle measure affects the length of the side opposite the angle. Create a non-right triangle, $\triangle FGH$. Measure each of its angles and the length of each of its sides.

b. Drag the vertices of $\triangle FGH$ to create several other triangles. How does the length of the side opposite the angle with the greatest measure compare to the lengths of the other sides?

c. How does the length of the side opposite the angle with the least measure compare to the lengths of the other sides?

6. a. Adjust the triangle so that $FG$ has the greatest length. Construct squares on the sides of $\triangle FGH$ as in exercise 3.

b. Create the interior of each square and measure its area. Then compute the sum of the areas of the two smaller squares.

c. Examine several triangles in which $FG$ is the longest side and the area of the square on $FG$ is less than the sum of the areas of the two smaller squares. What type of triangle is formed?

d. Repeat part (c) for several triangles in which $FG$ is the longest side and the area of the square on $FG$ is greater than the sum of the areas of the two smaller squares.

e. Repeat part (c) for several triangles in which $FG$ is the longest side and the area of the square on $FG$ is equal to the sum of the areas of the two smaller squares.

f. Use the results from parts (c–e) to complete the following statements.
If the square of the length of the longest side of a triangle is **greater than** the sum of the squares of the lengths of the two shorter sides, then the triangle is a(n) __________ triangle.

If the square of the length of the longest side of a triangle is **less than** the sum of the squares of the lengths of the two shorter sides, then the triangle is a(n) __________ triangle.

If the square of the length of the longest side of a triangle is **equal to** the sum of the squares of the lengths of the two shorter sides, then the triangle is a(n) __________ triangle.

This last statement is the converse of the Pythagorean Theorem.

7. a. Construct a right triangle, \(\triangle XYZ\).
   b. Construct a regular hexagon on each side of \(\triangle XYZ\). The sides of each hexagon should be congruent to the side of the triangle on which it is constructed.
   c. Create the interior of each hexagon and measure its area. Then compute the sum of the areas of the two smaller hexagons. Drag the vertices of \(\triangle XYZ\) and compare the sum to the area of the hexagon on the hypotenuse. What do you observe? How is this related to the Pythagorean Theorem?

---

**GSP Lab 11: Slides, Flips, and Turns (Sections 14-1 and 14-2)**

In this lab, we study transformational or “motion” geometry. A **transformation** is a function that changes a figure’s size, shape, or position.

**Reflections**

One such transformation is a **reflection**. A reflection moves a figure by flipping it over a line. This **reflecting line** represents a mirror over which objects are reflected.

1. a. Choose **Preferences** from the **Edit** menu. On the **Text** panel, choose **For All New Points** so that points are labeled when they’re created.
   b. Draw \(\triangle ABC\) and measure its sides and angles.
   c. Draw a line \(m\) anywhere on the sketch and select it. Choose **Mark Mirror** from the **Transform** menu.
   d. Select \(\triangle ABC\). Then choose **Reflect** from the **Transform** menu to reflect \(\triangle ABC\) in line \(m\). \(\triangle A'B'C'\) is the image of \(\triangle ABC\) under the reflection. The images of points \(A, B,\) and \(C\) are \(A', B',\) and \(C',\) respectively.

2. a. Measure the angles and sides of \(\triangle A'B'C'\). How are \(\triangle ABC\) and \(\triangle A'B'C'\) related?
   b. Change the shape of \(\triangle ABC\). Does the relationship still hold?
   c. Change the location of the reflecting line \(m\). Does the relationship still hold?

3. a. Imagine tracing \(\triangle ABC\) from \(A\) to \(B\) to \(C\) and back to \(A\). In what direction—clockwise or counterclockwise—would you move?
   b. Now imagine tracing \(\triangle A'B'C'\) from \(A'\) to \(B'\) to \(C'\) and back to \(A'\). In what direction would you move?
   c. In parts (a) and (b), you examined the orientations of \(\triangle ABC\) and \(\triangle A'B'C'\). Are the orientations of the two triangles the same?
4. a. Construct the segments joining each vertex of \( \triangle ABC \) to its image. How does the reflecting line seem to be related to each of these segments? (The segments can be colored using the **Color** command from the **Display** menu.)
b. Find the appropriate measurements to verify the conjecture from part (a).

5. Use the results from exercises 1–4 to answer the following questions.
a. How are the measure of an angle and the measure of its reflection related?
b. How are the length of a segment and the length of its reflection related?
c. How are a polygon and its reflection related?
d. How are the orientations of an object and its image under a reflection related?
e. How is the reflecting line related to the segment joining a point and its reflection?

**Translations**

Another transformation is a **translation**. A translation moves every point the same distance in the same direction. The distance and direction are often indicated by a vector.

6. a. Draw a quadrilateral \( HIJKLM \) and measure its sides and angles.
b. Draw \( XY \) to represent the vector. Select the endpoints of the segment in the order \( X, Y \). The order indicates the direction an object is to be moved—in this case, from \( X \) to \( Y \). Choose **Mark Vector** under the **Transform** menu.
c. To translate quadrilateral \( HIJKLM \) the distance and direction indicated by vector \( XY \), select quadrilateral \( HIJKLM \) and choose **Translate** from the **Transform** menu. A dialog box will appear. Choose **Marked**. The quadrilateral \( HIJKLM' \) that results is the translated image of quadrilateral \( HIJKLM \).

7. a. Measure the sides and angles of quadrilateral \( HIJKLM' \). How are quadrilaterals \( HIJKLM \) and \( HIJKLM' \) related?
b. Change the size and shape of quadrilateral \( HIJKLM \). Does the relationship still seem to hold?
c. Change the length and direction of the translation vector \( XY \). Does the relationship change?

8. a. Construct the segments joining each vertex of quadrilateral \( HIJKLM \) to its image in quadrilateral \( HIJKLM' \). What appears to be true about these segments?
b. Find the appropriate measurements to verify the conjecture in part (a).
c. Do an object and its translation image have the same orientation?

**Rotations**

A **rotation** moves a figure by turning it clockwise or counterclockwise about a fixed point. The fixed point is the **center of rotation**. An angle is often used to indicate the amount of rotation that is to take place.

9. a. Draw a triangle \( \triangle PQR \) and measure its sides and angles.
b. Create a point \( O \) to represent the center of rotation. With point \( O \) selected, choose **Mark Center** from the **Transform** menu.
c. Create \( \angle STU \) to indicate the amount of rotation. Select the points of the angle in the same order it could be measured. Choose **Mark Angle** from the **Transform** menu.
d. To rotate \( \triangle PQR \) around \( O \), select \( \triangle PQR \) and choose **Rotate** from the **Transform** menu. A dialog box will appear. Choose **Marked Angle**. The triangle \( \triangle P'Q'R' \) that results is the image of \( \triangle PQR \) under the rotation.
10. a. Measure the angles and sides of $\triangle P’Q’R’$. How are $\triangle PQR$ and $\triangle P’Q’R’$ related?
b. Does the relationship still hold when the shape of $\triangle PQR$ is changed? When the size of $\angle STU$ is changed?

11. a. Construct the segments joining each vertex of $\triangle PQR$ to the center of rotation, $O$.
Now construct the segments joining each vertex of the image $\triangle P’Q’R’$ to the center of rotation.
b. Three angles are formed. Each has its vertex at $O$, the center of rotation, one side passing through a vertex of $\triangle PQR$ and its other side passing through the corresponding vertex of $\triangle P’Q’R’$. What seems to be true about these three angles?
c. How do these angles appear to compare to $\angle STU$?
d. Find the appropriate measurements to verify the conjectures.
e. Do an object and its image under a rotation seem to have the same orientation? Explain.

12. a. Construct a right triangle $\triangle ABC$ with a right angle at $C$, a square on $\overline{BC}$, and a square on $\overline{AB}$. Also construct a perpendicular from $C$ to $\overline{AB}$ intersecting $\overline{AB}$ at $E$ and $\overline{AT}$ at $D$, as shown in Figure AIII-14.
b. Rotate $\triangle ABC’$ by “90°” about point $B$. What is its image?
c. Explain why the image of $\triangle ABC’$ is the triangle you found in part (b).
d. Select only the vertices of $\triangle ABC’$ and then choose Triangle Interior from the Construct menu.
e. Choose Area from the Measure menu. The area of $\triangle ABC’$ will be displayed in the upper left corner of the window.
f. In a similar way, find the area of $\triangle BC’C$. How do the areas of $\triangle ABC’$ and $\triangle BC’C$ compare? Why?
g. As above, calculate the areas of $\triangle BC’A’$ and $\triangle A’BE$.
h. How does the area of $\triangle ABC’$ compare to the area of the square $BCGC’$?
i. How does the area of $\triangle BCA’$ compare to the area of the rectangle $BEDA’$?

GSP Lab 12: Other Transformations (Sections 14-2 and 14-3)

If we combine a translation with a reflection, the result is a glide reflection.

Glide Reflections

1. a. Choose Preferences from the Edit menu. On the Text panel, choose For All New Points.
b. Draw $\triangle ABC$ and a translation vector $\overrightarrow{DE}$.
c. Select the endpoints of the segment in the order $D$, $E$ and choose Mark Vector from the Transform menu.
d. Construct a line $n$ parallel to $\overrightarrow{DE}$, select it, and choose Mark Mirror from the Transform menu.
e. Translate $\triangle ABC$ by the marked vector $\overrightarrow{DE}$ and then reflect its translation image over line $n$. Hide the intermediate triangle, $\triangle A’B’C’$, so that only the first and last triangles are showing. The last triangle, $\triangle A”B”C”$, is the image of $\triangle ABC$ under the glide reflection. The images of points $A$, $B$, and $C$ are $A”$, $B”$, $C”$, respectively.
f. Change the length and direction of $\overrightarrow{DE}$ and the position of line $n$. How do these changes affect the transformation?
g. Now we’ll create a custom tool to quickly perform the glide reflection. Select, in order, line $n$ and points $D$, $E$, $A$, and $A”$. Choose Create New Tool from the
Custom Tools menu. Call the tool “Glide Reflect.” Check Show Script View before clicking OK. In the script, double-click the first *Given*. Check Automatically Match Sketch Object, and click OK. (This saves you from having to click on this particular given each time.) Do the same for the next two givens, leaving only the pre-image as a *Given*. Close the script.

h. Choose the Custom Tools tool to activate the Glide Reflect tool. Click on the three sides of $\triangle A'B'C'$ to apply the glide reflection to them.

i. Repeat the transformation on the newest image triangle two more times. Why does it make sense to call this transformation a glide reflection?

j. Construct segments $\overline{AB'}$, $\overline{BB'}$, and $\overline{CC'}$ and find their midpoints. What appears to be true about the midpoints?

In the next exercise, we investigate a dilation. A dilation uses a fixed point and a scale factor to transform a figure. The fixed point is the center of dilation. The scale factor is a ratio that indicates the amount of dilation.

**Dilations or Size Transformations (Section 14-3)**

2. a. Draw $\triangle FGH$ and measure its sides and angles.

b. Create a point $O$ to represent the center of dilation. Then choose Mark Center from the Transform menu.

c. Select $\triangle FGH$ and choose Dilate from the Transform menu. A dialog box will appear. Choose By Fixed Ratio. Enter 2.5 to 1 for the scale factor. $\triangle F'G'H'$ is the image of $\triangle FGH$ under the dilation. The images of points $F$, $G$, and $H$ are $F'$, $G'$, and $H'$, respectively.

d. Measure the sides and angles of $\triangle F'G'H'$. How are $\triangle FGH$ and $\triangle F'G'H'$ related? Why?

e. Change the shape of $\triangle FGH$. Do the relationships still hold?

f. Change the location of point $O$. Do the relationships change?

g. Find the ratio of the length of each side of $\triangle FGH$ to the lengths of the corresponding side in $\triangle F'G'H'$. How do the ratios compare to the scale factor of the dilation?

h. Do an object and its image under a dilation have the same orientation? Explain.

i. Construct rays $\overline{OF}$, $\overline{OG}$, and $\overline{OH}$. What other point does each ray appear to pass through?

j. How are the distances $OF$ and $OF'$ related? $OG$ and $OG'$? $OH$ and $OH'$?

3. Repeat exercise 2 (a–c, g, i, and j) using a different scale factor from 2.5 to 1.

**Comparing the Ratio of the Areas of a Triangle and Its Image to the Scale Factor of the Size Transformation**

4. a. Proceed as in exercise 2; construct a triangle and choose a point $O$ to be the center of dilation.

b. Select only the vertices and from the Construct menu choose Triangle Interior and then from the Measure menu choose Area. The area of the triangle automatically labeled $\triangle ABC$ will appear in the upper left corner of the screen (see Figure AIII–15).

c. Next select the vertices of the triangle as well as the sides of the triangle. Double-click on $O$ and choose Dilate from the Transform menu. In the dialog box, choose
Using a Geometry Drawing Utility

By Fixed Ratio and enter 2 to 1 for the scale factor. Then click Dilate. The image triangle will appear.

d. Select only the vertices of the image triangle automatically labeled $\triangle A'B'C'$ and then choose Triangle Interior from the Construct menu.

e. Choose Area from the Measure menu. The area of $\triangle A'B'C'$ will be displayed in the upper left corner of the window.

f. Choose Calculate from the Measure menu and click on the Area $\triangle ABC$ that appeared earlier in the upper left corner of the window. Then click at the divide symbol, $\div$, in the small New Calculation window and click on Area of $\triangle ABC$. The ratio 4 should be displayed.

g. Next drag a vertex or a side of $\triangle ABC$. Notice that the displayed areas of the triangles change but the ratio stays the same.

h. Conjecture a relationship between a scale factor and the ratio of the area of the image of a triangle to the area of the triangle.

i. Check your conjecture in part (h) for different scale factors.

j. Repeat parts (a) through (l) for quadrilaterals.

k. Given two similar triangles with ratio $r$ between corresponding sides, what is the ratio of their areas in terms of $r$?

Area $\triangle ABC = 3.48 \text{ cm}^2$
Area $\triangle A'B'C' = 13.91 \text{ cm}^2$

\[
\frac{(\text{Area } \triangle A'B'C')}{(\text{Area } \triangle ABC)} = 4.00
\]

Assessment A-III

The following problems are suggested for further investigation using GSP. Problems 1–4 are step-by-step activities, and problems 5–10 are open-ended problems.

1. **Inscribing a Circle in a Triangle** (Section 12-3)

Steps to Proceed

a. Construct any triangle.

b. Construct a bisector of one angle of the triangle using Angle Bisector from the Construct menu.

c. Construct a point on the angle bisector with the Construct menu command Point On Bisector. Construct perpendicular segments from the point to the sides of the angle using the Perpendicular Line and Intersection commands from the Construct menu. (You may need to move the point toward the bisector vertex to do this.)

d. Measure the lengths of the perpendicular segments using the Measure menu.

e. Move the point along the angle bisector by clicking the mouse pointer on it and dragging it along the
bisector. As the point is dragged, observe the measures shown.

f. Make a conjecture about any observed results.
g. Construct the incircle of the triangle. The incircle is the circle that is inside the triangular region and is tangent to each of the sides of the triangle. The point at which the three angle bisectors intersect is the center of the incircle. The radius is the length of the perpendicular segment from the center to one of the sides.

2. Angles in Circles
   Some angles with vertices on a circle are related to angles with vertices at the circle's center. This investigation explores such a relationship.

   **Steps to Proceed**
   a. Draw a circle. Use the Segment tool to construct two segments connecting the center to points on the circle (in other words, construct two radii). The angle between these segments is called a central angle.
   b. Measure the central angle using the Angle command from the Measure menu.
   c. Construct the arc between the two circle points by selecting them and the circle, then choosing Arc On Circle from the Construct menu. With the arc selected, choose Thick from the Line Width submenu of the Display menu to distinguish the arc from the rest of the circle. (If necessary, drag an arc endpoint until the arc is a minor arc; in other words, less than half the circumference.) With the arc still selected, choose Arc Angle from the Measure menu. How does this value compare to the earlier measure?
   d. Construct a third point on the circle, but not on the arc. Construct two chords, each connecting the new point with an arc endpoint. The angle between the two chords is an inscribed angle.
   e. Measure the inscribed angle using the Angle command.
   f. Move the vertex of the inscribed angle and make a conjecture about the relationship between the measure of an inscribed angle and the central angle that intercepts the same arc.

   **Extension:** If the arc is a semicircle, what is the measure of the inscribed angle?

3. Ratios and Slopes (Section 12-5)
   This investigation explores the relationship between slopes and the tangent ratio.

   **Steps to Proceed**
   a. Choose Define Coordinate System from the Graph menu to construct a coordinate system.
   b. Construct line OA, where O is the origin and A is somewhere in the first quadrant.
   c. Construct point P on the line. Construct the line through P and perpendicular to the x-axis, then construct point X where the new line and the x-axis intersect.
   d. Construct OX, PX, and OP, then measure their lengths.
   e. Measure the following ratios using the Ratio command from the Measure menu: \( \frac{OX}{PX} \). \( \frac{PX}{OP} \). \( \frac{OX}{OP} \).
   f. Move point P up and down the line. What happens to the ratios?
   g. Select OA and choose Slope from the Measure menu. Describe the ratios in terms of slope.

   **Extension:** Drag point A while continuing to observe the ratios. What are the maximum and minimum values, if any, for the ratios?

4. Symmetry (Section 14-4)
   GSP can be used to design a logo for a company or for fun.

   **Steps to Proceed**
   a. Draw a line on the screen.
   b. Use the Transform menu command Mark Mirror to mark the line as a mirror (reflecting line).
   c. Use any GSP construction tools to design half of a logo on one side of the line.
   d. Select the object (the half of the design created) to be reflected.
   e. Choose the Reflect command from the Transform menu, and GSP will construct the reflected image to complete the design.

   **Extension:** Try other features of the Transform menu to design a logo with 120 degree symbol rotational symmetry. Construct one-third of the design and use the Rotate command to create the rest of the design.

5. a. Construct any regular polygon inscribed in a circle.
   b. Connect vertices to the center.
   c. Construct an altitude of one of the triangles formed, then measure its length.
   d. Find the area of each triangle formed.
   e. Find the area of the regular polygon.
   f. Find the perimeter of the regular polygon.
   g. What is the ratio of the area in (e) to the height in (c)?

6. a. Draw any circle.
   b. Inscribe a regular polygon in the circle.
   c. Find the measure of the diameter of the circle and the perimeter of the polygon. Find the ratio of the perimeter to the length of the diameter.
   d. Repeat the process using a polygon with twice as many sides.
   e. Find the ratio again.
   f. Repeat the process in (d) two more times. What do you expect the ratio to be? Why?

7. a. Inscribe a circle in a square. Find the percentage of the area in the square not covered by the circular region.
b. Inscribe a square in a circle. Find the percentage of the area of the circle not covered by the square region.
c. Use the answers from (a) and (b) to determine whether a square peg might fit better into a round hole or a round peg might fit better in a square hole.

8. a. Draw a rectangle with two circles inside, pictured as follows:

![Diagram of a rectangle with two circles inside]

The circles are tangent to each other (touch at only 1 point) and are tangent to the sides of the rectangle. Find the percentage of the area of the rectangle not covered by the circular regions.
b. Repeat the process in (a) using four circles.
c. Make a conjecture about the percentage of the area of any rectangle not covered by circular regions when constructed in this manner.

b. Draw any line and move the line through the polygon.
c. Stop moving the line when you estimate the polygon is divided into two equal areas.
d. Find the areas of the two subshapes to check the estimate.
e. Repeat (a) through (d) to practice your area estimation skills.

10. a. Draw any rectangle and a segment, shown as follows:

![Diagram of a rectangle with a segment]

b. Move the segment across the rectangle and estimate when 60% of the area is to the right of the segment.
c. Measure the areas to check.
d. Repeat steps (a) through (c) to practice area estimation skills with other percentages.

11. a. Construct any $\triangle ABC$ and its centroid $G$ (the intersection of the medians).
b. Measure the areas of $\triangle ABG$, $\triangle BCG$, and $\triangle ACG$.
Drag a vertex of $\triangle ABC$ and observe the relationship among the areas of the three triangles. State a conjecture concerning the areas of the three triangles.

12. Construct a figure similar to the one below.

![Diagram of a polygon]

13. a. Construct $\triangle ABC$, its centroid $G$ (see exercise 11), its orthocenter $H$ (the intersection of the altitudes), and its circumcenter $O$ (the center of the circumscribing circle).
b. Construct a line through $O$ and $G$. Drag one of the vertices of the triangle. What do you observe about $O$, $G$, and $H$? State your conjecture.
c. Calculate the ratio $\frac{OG}{HG}$. Drag one of the vertices of $\triangle ABC$ and state a conjecture concerning the ratio.